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6 

Mercury Safety

7 

Power saver

8 

Recycling

9 

China only

Contains Mercury, Dispose According to Local, State or Federal 
Laws.(U.S.A. only)

This printer contains advanced energy conservation technology 
that reduces power consumption when it is not in active use.

When the printer does not receive data for an extended period of 
time, power consumption is automatically lowered. 

ENERGY STAR and the ENERGY STAR mark are registered U.S. 
marks. 

For more information on the ENERGY STAR program see http://
www.energystar.gov

For ENERGY STAR certified models, the ENRGY STAR label will be 
on your machine. Check if your machine is ENERGY STAR 
certified.

Recycle or dispose of the packaging material for this product in an 
environmentally responsible manner.
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10 

Correct disposal of this product (Waste electrical & 
electronic equipment)

(Applicable in the european union and other 
european countries with separate collection 
systems)

(The United States of America only)

Dispose unwanted electronics through an approved recycler. To find the nearest 
recycling location, go to our website: www.samsung.com/recyclingdirect Or 
call, (877) 278 - 0799

11 

Taiwan only

12 

Radio frequency emissions

FCC information to the user

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: 

• This device may not cause harmful interference, and

• This device must accept any interference received, including interference 
that may cause undesired operation.

This marking on the product, accessories or literature indicates that the 
product and its electronic accessories (e.g. charger, headset, USB cable) 
should not be disposed of with other household waste at the end of 
their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these 
items from other s of waste and recycle them responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for details of 
where and how they can take these items for environmentally safe 
recycling.

Business users should contact their supplier and check the terms and 
conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for 
disposal.
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This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user's authority to operate the 
equipment.

 

Canadian radio interference regulations

This digital apparatus does not exceed the Class B limits for radio noise 
emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and 
Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques 
applicables aux appareils numériques de Classe B prescrites dans la norme sur le 
matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et 
Sciences Canada.

13 

United States of America

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15

Low power, Radio LAN devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 
your printer system. This section is only applicable if these devices are present. 
Refer to the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the 
United States of America if an FCC ID number is on the system label.
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The FCC has set a general guideline of 20 cm (8 inches) separation between the 
device and the body, for use of a wireless device near the body (this does not 
include extremities). This device should be used more than 20 cm (8 inches) 
from the body when wireless devices are on. The power output of the wireless 
device (or devices), which may be embedded in your printer, is well below the 
RF exposure limits as set by the FCC.

This transmitter must not be collocated or operation in conjunction with any 
other antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired 
operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

 

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination 
the radio frequency exposure limit of 1m W/cm2 may be exceeded at 
distances close to the antenna installed. Therefore, the user must maintain 
a minimum distance of 20cm from the antenna at all times. This device 
cannot be colocated with another transmitter and transmitting antenna.

 

14 

Russia only
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15 

Germany only

16 

Turkey only

17 

Canada only

This product meets the applicable Industry Canada technical specifications. / Le 
present materiel est conforme aux specifications techniques applicables 
d’Industrie Canada.

The Ringer Equivalence Number (REN) is an indication of the maximum number 
of devices allowed to be connected to a telephone interface. The termination of 
an interface may consist of any combination of devices subject only to the 
requirement that the sum of the RENs of all the devices not exceed five. / L’indice 
d’equivalence de la sonnerie (IES) sert a indiquer le nombre maximal de 
terminaux qui peuvent etre raccordes a une interface telephonique. La 
terminaison d’une interface peut consister en une combinaison quelconque de 
dispositifs, a la seule condition que la somme d’indices d’equivalence de la 
sonnerie de tous les dispositifs n’excede pas cinq.

18 

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any 
person to use a computer or other electronic device to send any message via a 
telephone facsimile machine unless such message clearly contains in a margin 
at the top or bottom of each transmitted page or on the first page of the 
transmission the following information:

1 the date and time of transmission

2 identification of either business, business entity or individual sending the 
message; and

3 telephone number of either the sending machine, business, business entity 
or individual.
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The Telephone Company may make changes in its communications facilities, 
equipment operations or procedures where such action is reasonably required 
in the operation of its business and is not inconsistent with the rules and 
regulations in FCC Part 68. If such changes can be reasonably expected to render 
any customer terminal equipment incompatible with telephone company 
communications facilities, or require modification or alteration of such terminal 
equipment, or otherwise materially affect its use or performance, the customer 
shall be given adequate notice in writing, to allow the customer an opportunity 
to maintain uninterrupted service

19 

Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for this machine 
may be found on the label located on the bottom or rear of the machine. In some 
instances you may need to provide these numbers to the telephone company.

The Ringer Equivalence Number (REN) is a measure of the electrical load placed 
on the telephone line, and is useful for determining whether you have 
“overloaded” the line. Installing several s of equipment on the same telephone 
line may result in problems making and receiving telephone calls, especially 
ringing when your line is called. The sum of all Ringer Equivalence Numbers of 
the equipment on your telephone line should be less than five in order to assure 
proper service from the telephone company. In some cases, a sum of five may 
not be usable on your line. If any of your telephone equipment is not operating 
properly, you should immediately remove it from your telephone line, as it may 
cause harm to the telephone network.

The equipment complies with Part 68 of the FCC rules and the requirements 
adopted by the ACTA. On the rear of this equipment is a label that contains, 
among other information, a product identifier in the format US:AAAEQ##TXXXX. 
If requested, this number must be provided to the telephone company.

 

FCC Regulations state that changes or modifications to this equipment not 
expressly approved by the manufacturer could void the user’s authority to 
operate this equipment. In the event that terminal equipment causes harm 
to the telephone network, the telephone company should notify the 
customer that service may be stopped. However, where prior notice is 
impractical, the company may temporarily cease service, providing that 
they:

a promptly notify the customer.
b give the customer an opportunity to correct the equipment problem.
c inform the customer of the right to bring a complaint to the Federal 

Communication Commission pursuant to procedures set out in FCC 
Rules and Regulations Subpart E of Part 68.

 

You should also know that:

• Your machine is not designed to be connected to a digital PBX system.

• If you intend to use a computer modem or fax modem on the same phone 
line as your machine, you may experience transmission and reception 
problems with all the equipment. It is recommended that no other 
equipment, except for a regular telephone, share the line with your 
machine.
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• If your area experiences a high incidence of lightning or power surges, we 
recommend that you install surge protectors for both the power and the 
telephone lines. Surge protectors can be purchased from your dealer or 
telephone and electronic specialty stores.

• When programming emergency numbers and/or making test calls to 
emergency numbers, use a non-emergency number to advise the 
emergency service dispatcher of your intentions. The dispatcher will give 
you further instructions on how to actually test the emergency number.

• This machine may not be used on coin service or party lines.

• This machine provides magnetic coupling to hearing aids.

You may safely connect this equipment to the telephone network by means of 
a standard modular jack, USOC RJ-11C.

20 

Replacing the Fitted Plug (for UK Only)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug 
and has a 13 amp fuse. When you change or examine the fuse, you must re-fit 
the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost 
the fuse cover, do not use the plug until you have another fuse cover. 

Contact the people from you purchased the machine.

The 13 amp plug is the most widely used in the UK and should be suitable. 
However, some buildings (mainly old ones) do not have normal 13 amp plug 
sockets. You need to buy a suitable plug adaptor. Do not remove the moulded 
plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you 
plug it into a socket.

 

Important warning: 

If the wires in the mains lead do not match the colors marked in your plug, do 
the following:

You must connect the green and yellow wire to the pin marked by the letter “E” 
or by the safety ‘Earth symbol’ or colored green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter “N” or 
colored black.

You must earth this machine.

The wires in the mains lead have the following color code:

• Green and Yellow: Earth

• Blue: Neutral

• Brown: Live
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You must connect the brown wire to the pin which is marked with the letter “L” 
or colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

21 

Declaration of conformity (European countries)

Approvals and Certifications

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of 
the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC, approximation of the laws of 
the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity. A full declaration, defining the relevant Directives and referenced 
standards can be obtained from your Samsung Electronics Co., Ltd. 
representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal 
Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European 
single terminal connection to the analogue public switched telephone network 
(PSTN) in accordance with Directive 1999/5/EC. The product has been designed 
to work with the national PSTNs and compatible PBXs of the European 
countries:

In the event of problems, you should contact the Euro QA Lab of Samsung 
Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21. To assist in the use and application 
of terminal equipment which complies with this standard, the European 
Telecommunication Standards Institute (ETSI) has issued an advisory document 
(EG 201 121) which contains notes and additional requirements to ensure 
network compatibility of TBR21 terminals. The product has been designed 
against, and is fully compliant with, all of the relevant advisory notes contained 
in this document.

Hereby, Samsung Electronics, declares that this [SF-76xP Series] is in 
compliance with the essential requirements and other relevant 
provisions of Low Voltage Directive (2006/95/EC), EMC Directive (2004/
108/EC).

The declaration of conformity may be consulted at 
www.samsung.com, go to Support > Download center and enter 
your printer (MFP) name to browse the EuDoC. 
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China only



1105.  Appendix

Copyright
© 2011 Samsung Electronics Co., Ltd. All rights reserved.

This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.

Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and the Samsung logo are trademarks of Samsung Electronics Co., Ltd.

• Microsoft, Windows, Windows Vista, Windows 7, and Windows Server 2008 R2 are either registered trademarks or trademarks of Microsoft Corporation.

• True, LaserWriter, and Macintosh are trademarks of Apple Computer, Inc.

• All other brand or product names are trademarks of their respective companies or organizations.

Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.

REV. 1.00
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User’s Guide

This guide provides information about installation, advanced configuration, 
operation and troubleshooting on various OS environments. 
Some features may not be available depending on models or countries.

BASIC
This guide provides information concerning installation, basic operation and troubleshooting 
on windows.
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1. Software Installation
This chapter provides instructions for installing essential and helpful software for use in an environment where the 
machine is connected via a cable. A locally connected machine is a machine directly attached to your computer using 
the cable.

• Installation for Macintosh 114
• Reinstallation for Macintosh 115
• Installation for Linux 116
• Reinstallation for Linux 118
 

• If you are a Windows OS user, refer to the Basic Guide for installing the machine’s driver.

• Only use a USB cable no longer then 3 meter (118 inches).

 



1141.  Software Installation

Installation for Macintosh
1 Make sure that the machine is connected to your computer and 

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your Macintosh desktop.

4 Double-click the MAC_Installer folder > Installer OS X icon.

5 Click Continue.

6 Read the license agreement and click Continue.

7 Click Agree to agree to the license agreement.

8 When the message that warns that all applications will close on your 
computer appears, click Continue.

9 Click Continue on the User Options Pane.

10 Click Install. All components necessary for machine operations will be 
installed.

If you click Customize, you can choose individual components to install.

11 Enter the password and click OK.

12 Installing software requires you to restart your computer. Click Continue 
Installation.

13 After the installation is finished, click Quit or Restart.

14 Open the Applications folder > Utilities > Print Setup Utility.

• For Mac OS X 10.5 -10.7, open the Applications folder > System 
Preferences and click Print & Fax.

15 Click Add on the Printer List.

• For Mac OS X 10.5 -10.7, click the “+” folder icon; a display window 
will pop up.

16 Click Default Browser and find the USB connection.

• For Mac OS X 10.5-10.7, click Default and find the USB connection.

17 For Mac OS X 10.4, if Auto Select does not work properly, select Samsung 
in Print Using and your machine name in Model.

• For Mac OS X 10.5-10.7, if Auto Select does not work properly, select 
Select a driver to use... and your machine name in Print Using. 

Your machine appears on the Printer List, and is set as the default 
machine.

18 Click Add.

 

To install the fax driver: 

1 Open the Applications folder > Samsung > Fax Queue Creator.
2 Your machine appears on the Printer List
3 Select machine to use and Click Create button
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Reinstallation for Macintosh
If the printer driver does not work properly, uninstall the driver and reinstall it.

1 Make sure that the machine is connected to your computer and 
powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Double-click the CD-ROM icon that appears on your Macintosh desktop.

4 Double-click the MAC_Installer folder > Uninstaller OS X icon.

5 Enter the password and click OK.

6 When the uninstall is done, click OK.

 

If a machine has already been added, delete it from the Print Setup Utility 
or Print & Fax.
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Installation for Linux
You need to download Linux software packages from the Samsung website to 
install the printer software (http://www.samsung.com > find your product > 
Support or Downloads).

1 

Installing the Unified Linux Driver

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

 

You must log in as a super user (root) to install the machine software. If you 
are not a super user, ask your system administrator.

 

3 From the Samsung website, download the Unified Linux Driver package 
to your computer.

4 Right-click the Unified Linux Driver package and extract the package. 

5 Double click cdroot > autorun.

6 When the welcome screen appears, click Next.

7 When the installation is complete, click Finish.

The installation program added the Unified Driver Configurator desktop icon 
and the Unified Driver group to the system menu for your convenience. If you 
have any difficulties, consult the on-screen help that is available through your 
system menu or from the driver package Windows applications, such as Unified 
Driver Configurator or Image Manager.

2 

Installing the Smart Panel

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type in root in the 
Login field and enter the system password.

 

You must log in as a super user (root) to install the machine software. If you 
are not a super user, ask your system administrator.

 

3 From the Samsung website, download the Smart Panel package to your 
computer.

4 Right-click the Smart Panel package and extract the package. 

5 Double click cdroot > Linux > smartpanel > install.sh.
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3 

Installing the Printer Settings Utility

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

 

You must log in as a super user (root) to install the machine software. If you 
are not a super user, ask your system administrator.

 

3 From the Samsung website, download the Printer Settings Utility 
package to your computer.

4 Right-click the Printer Settings Utility package and extract the 
package. 

5 Double click cdroot > Linux > psu > install.sh.
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Reinstallation for Linux
If the printer driver does not work properly, uninstall the driver and reinstall it. 

1 Make sure that the machine is connected to your computer and 
powered on.

2 When the Administrator Login window appears, type “root” in the 
Login field and enter the system password.

You must log in as a super user (root) to uninstall the printer driver. If you 
are not a super user, ask your system administrator.

3 Click the icon at the bottom of the desktop. When the Terminal screen 
appears, type in the following.

[root@localhost root]#cd /opt/Samsung/mfp/uninstall/

[root@localhost uninstall]#./uninstall.sh

4 Click Uninstall.

5 Click Next. 

6 Click Finish.



2. Useful Setting Menus
This chapter explains how to browse the current status of your machine, and the method of setting for advanced 
machine setup. 

• Before you begin reading a chapter 120
• Fax menu 121
• Copy menu 124
• System setup 126 
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Before you begin reading a chapter
This chapter explains all the features available for this series' models to help users easily understand the features.

You can check the features available for each model in the Basic Guide (see "Menu overview" on page 29).

The following are tips for using this chapter

• The control panel provides access to various menus to set up the machine or use the machine’s functions. These menus can be accessed by pressing (Menu).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• For models that do not have the (Menu) on the control panel, this feature is not applicable (see "Control panel overview" on page 23).

• Some menu names may differ from your machine depending on its options or the models.



1212.  Useful Setting Menus

Fax menu
1 

Fax Feature

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press  (fax) > (Menu) > Fax Feature on the control panel.

Item Description

Darkness
Adjusts the brightness level to scan an original that is 
easier to read, when the original contains faint 
markings and dark images (see "Darkness" on page 51).

Contrast 
Adjusts the contrast level to scan an original that is 
easier to read, when the original contains too faint or 
too dark contents.

Resolution

The default document settings procedure good results 
when using typical text-based originals. However, if you 
send originals that are of poor quality, or contain 
photographs, you can adjust the resolution to produce 
a higher quality fax (see "Resolution" on page 56).

Scan Size Sets the image size.

Multi Send

Sends a fax to multiple destinations (see "Sending a fax 
to multiple destinations" on page 55).

 

You cannot send a color fax using this feature. 

 

Delay Send

Sets your machine to send a fax at a later time when you 
will not be present (see "Delaying a fax transmission" on 
page 158).

 

You cannot send a color fax using this feature. 

 

Priority Send

Scans the original into memory and immediately 
transmits it when the current operation is finished. 
Priority transmission will interrupt a sending to multiple 
destinations between stations (example, when the 
transmission to station A ends, before transmission to 
station B begins) or between redial attempts (see 
"Sending a priority fax" on page 160).

Forward

Forwards the received or sent fax to other destination 
by a fax or PC. If you are out of office but have to receive 
the fax, this feature may be useful.

• See "Forwarding a sent fax to another destination" 
on page 160.

• See "Forwarding a received fax" on page 160.

Item Description



Fax menu

1222.  Useful Setting Menus

2 

Sending Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see"Menu overview" on 
page 29).

 

To change the menu options:

• Press  (fax) > (Menu) > Fax Setup > Sending on the control panel.

Secure Receive

Stores the received fax in memory without printing out. 
To print received documents, you need to enter the 
password. You can prevent your received faxes from 
being accessed by unauthorized people (see "Receiving 
in secure receiving mode" on page 164).

Add Page
Adds additional documents to a reserved delay fax job 
(see "Adding documents to a reserved fax" on page 
159).

Cancel Job
Cancels the delayed fax job which is saved in memory 
(see "Canceling a reserved fax job" on page 159).

Item Description

Item Description

Redial Times
Sets the number of redial attempts. If you enter 0, the 
machine will not redial.

Redial Term Sets the time interval before automatic redialling. 

Prefix Dial
Sets a prefix of up to five digits. This number dials 
before any automatic dial number is started. It is useful 
for accessing a PABX exchange.

ECM Mode
Sends faxes using error correction mode (ECM) to 
makes sure the faxes are sent smoothly without any 
error. It may take more time.

Send Report

Sets the machine to print a report whether a fax 
transmission was successfully completed or not. If you 
select On-Error, the machine prints a report only when 
a transmission is not successful.

Image TCR
Prints a transmission report with a minimized image of 
the first page of the fax sent. 

Dial Mode
Sets the dialing mode to either tone or pulse. This 
setting may not be available depending on your 
country.
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3 

Receiving Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press  (fax) > (Menu)> Fax Setup > Receiving on the control 

panel.

Item Description

Receive Mode Selects the default fax receiving mode.

Ring To Answer
Specifies the number of times the machine rings before 
answering an incoming call.

Stamp RCV Name
Automatically prints the page number, and the date 
and time of reception at the bottom of each page of a 
received fax.

RCV Start Code

Initiates fax reception from an extension phone 
plugged into the EXT socket on the back of the 
machine. If you pick up the extension phone and hear 
fax tones, enter the code. It is preset to *9* at the 
factory.

Auto Reduction
Automatically reduces an incoming fax page to fit the 
size of the paper loaded in the machine.

Discard Size
Discards a specific length from the end of the received 
fax.

Junk Fax Setup
Blocks any unwanted faxes that you stored in the 
memory as junk fax numbers. This setting may not be 
available depending on your country.

DRPD Mode

 Enables a user to use a single telephone line to answer 
several different telephone numbers. You can set the 
machine to recognize different ring patterns for each 
number. This setting may not be available depending 
on your country (see "Receiving faxes using DRPD 
mode" on page 163).

Item Description



1242.  Useful Setting Menus

Copy menu
4 

Copy Feature

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press (copy) > (Menu) > Copy Feature on the control panel.

Item Description

Scan Size Sets the image size.

Reduce/Enlarge
Reduces or enlarges the size of a copied image (see 
"Reduced or enlarged copy" on page 51).

Darkness
Adjusts the brightness level to make a copy that is 
easier to read, when the original contains faint 
markings and dark images (see "Darkness" on page 57).

Contrast 
Adjusts the contrast level to scan an original that is 
easier to read, when the original contains too faint or 
too dark contents (see "Contrast" on page 51).

Original Type
Improves the copy quality by selecting the document 
type for the current copy job (see "Original Type" on 
page 51).

Layout

Adjusts the layout format such as Normal, 2/4-up.

• 2-up or 4-up Copying : Reduces the size of the 
original images and prints 2 or 4 pages onto one 
sheet of paper. This copy feature is available only 
when you load originals into the document feeder.

Adjust Bkgd.

Prints an image without its background. This copy 
feature removes the background color and can be 
helpful when copying an original containing color in 
the background, such as a newspaper or a catalog.

• Off: Does not use this feature.

• Auto: Optimizes the background.

• Enhance Lev.1~2: The higher the number is, the 
more vivid the background is.

• Erase Lev.1~4: The higher the number is, the lighter 
the background is.

Item Description

1
2

1 2

3 4



Copy menu

1252.  Useful Setting Menus

5 

Copy Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press (copy) > (Menu) > Copy Setup on the control panel.

Item Description

Change Default
Resets the value or setting to the printer’s out-of-box 
state.
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System setup
6 

Machine Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press (Menu) > System Setup > Machine Setup on the control panel.

Item Description

Machine ID
Sets the machine ID which will be printed at the top of 
each fax page that you send.

Fax Number
Sets the fax number which will be printed at the top of 
each fax page that you send.

Date & Time Sets the date and time.

Clock Mode
Selects the format for displaying time between 12 hr. and 
24 hr. 

Language
Sets the language of the text that appears on the control 
panel display.

Power Save

Sets how long the machine waits before going to power 
save mode.

When the machine does not receive data for an extended 
period of time, power consumption is automatically 
lowered. 

Wakeup Event

You can set the condition to wake up from power-save 
mode. Set the item on.

• Button Press: When you press any button except 
power button, the machine wake up from the power 
save mode.

• Scanner: When you insert paper in the Document 
feeder, the machine wakes up from the power save 
mode.

System Timeout
Sets the time that the machine remembers previously 
used copy settings. After the timeout, the machine 
restores the default copy settings.

Altitude Adj.
Optimize print quality according to the machine’s 
altitude.

Item Description
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Paper Setup

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press (Menu) > System Setup > Paper Setup on the control panel.

Auto Continue

Determine whether or not the machine continues 
printing when it detects the paper does not match the 
paper settings.

• Off: If a paper mismatch occurs, the machine waits 
until you insert the correct paper. 

• On: If a paper mismatch occurs, an error message will 
display. The machine waits for about 30 second, then 
automatically clear the message and continue 
printing. 

Paper Mismatch
Determine whether to disregard the paper mismatch 
error or not. Select Off, then the machine does not stop 
printing even if the paper mismatches.

Paper Substit.

Automatically substitutes the printer driver’s paper size 
to prevent the paper mismatch between Letter and A4. 
For example, if you have A4 paper in the tray but you set 
the paper size to Letter in the printer driver, the machine 
prints on A4 paper and vice versa.

Toner Save

Activating this mode extends the life of your toner 
cartridge and reduces your cost per page beyond what 
one would experience in the normal mode, but it reduces 
print quality.

Item Description

Item Description

Paper Size
Sets the paper size as A4, Letter, or other paper sizes, 
according to your requirements.

Paper Type Chooses the type of the paper for each tray.

Margin Sets the margins for the document.



System setup

1282.  Useful Setting Menus

8 

Sound / Volume

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press (Menu) > System Setup > Sound/Volume on the control panel.

Item Description

Key Sound Turns the key sound on or off. With this option set to on, 
a tone sounds each time a key is pressed.

Alarm Sound
Turns the alarm sound on or off. With this option set to 
on, an alarm tone sounds when an error occurs or fax 
communication ends.

Speaker

Turns on or off the sounds from the telephone line 
through the speaker, such as a dial tone or a fax tone. 
With this option set to Comm. which means the speaker 
is on until the remote machine answers.

 

You can adjust the volume level using On Hook 
Dial or a handset, You can adjust the speaker 
volume only when the telephone line is 
connected.

a Press (fax) on the control panel.

b Press On Hook Dial or pick up the handseta. A 
dial tone sounds from the speaker.

c Press the left/right arrow until you hear the 
volume you want.

d Press On Hook Dial or OK (for handset) to save 
the change and return to ready mode.

 

Ringer
Adjusts the ringer volume. For the ringer volume, you can 
select Off, Low, Mid, and High level.

a. The United States of America only.

Item Description
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Report

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

To change the menu options:

• Press (Menu) > System Setup > Report on the control panel.

10 

Maintenance

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

Item Description

All Report Prints all kinds of reports that this machine provides.

Configuration Prints a report on the machine's overall configuration.

Supplies Info. Prints supplies’ information page. 

Address Book 
Prints all of the email addresses currently stored in the 
machine’s memory.

Fax Send

Prints a transmission report including the fax number, 
the number of pages, the elapsed time of the job, the 
communication mode, and the communication results 
for fax job. You can set up your machine to 
automatically print a transmission confirmation report 
after each fax job. 

Fax Sent
Prints information on the faxes you have recently sent. 
You can set the machine to automatically print this 
report every 50 communications.

Fax Received
Prints information on the faxes you have recently 
received.

Schedule Jobs
Prints the document list currently stored for delayed 
faxes along with the starting time and type of each 
operation.

Junk Fax Prints the fax numbers specified as junk fax numbers.

Usage Counter
Prints a usage page. The usage page contains the total 
number of pages printed

Fax Options Prints the information of a fax reports.

Item Description



System setup

1302.  Useful Setting Menus

To change the menu options:

• Press (Menu) > System Setup > Maintenance on the control panel.

11 

Clear Setting

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 29).

 

Item Description

CLR Empty Msg.
When toner cartridge is empty, this option appears. You 
can clear the empty message.

Supplies Life
Shows the supply life indicators (see "Monitoring the 
supplies life" on page 68).

Serial No.
Shows the machine’s serial number. When you call for 
service or register as a user on the Samsung website, you 
can find this.

TonerLow Alert
Customizes the level to alert toner low or toner empty 
(see "Setting the toner low alert" on page 69).

Adjust Shading 

Use this menu when the copy or scan images are fuzzy or 
blurry.

 

To Adjust Shading :

a Load white paper face down into the 
document feeder.

b Press (Menu) > System Setup > 

Maintenance > Adjust shading > Yes on the 
control panel.

c  The machine automatically feeds blank paper 
from the document feeder and outputs it after 
adjusting the white level.

 

Item Description
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To change the menu options:

•  Press (Menu) > System Setup > Clear Setting on the control panel.

Item Description

All Settings
Clears all of the data stored in memory and resets all of 
your settings to the factory default.

Fax Setup Restores all of the fax options to the factory default.

Copy Setup Restores all of the copy options to the factory default.

System Setup Restores all of the system options to the factory default.

Address Book Clears all of the email address entries stored in memory.

Fax Sent Clears all records of sent faxes.

Fax Received Clears all records of received faxes.



3. Special Features
This chapter explains special copying, scanning, faxing, and printing features.

• Altitude adjustment 133
• Entering various characters 134
• Setting up the address book 135
• Printing features 139
• Scan features 151
• Fax features 157
 

• The procedures in this chapter are mainly based on Windows 7.

• It may be necessary to press OK to navigate to lower-level menus for some models.
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Altitude adjustment
Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

1 High3
2 High2
3 High1
4 Normal

You can set the altitude value from Device Settings in SamsungEasy Printer 
Manager program or Machine section in PrinterSettings Utility program.

• For Windows and Macintosh users, see "Device Settings" on page 172.

• For Linux users, see "Using Smart Panel" on page 175.

 

You can also set the altitude in System Setup > Machine Setup > Altitude 
Adj.option on the machine’s display (see "Menu overview" on page 29).

 

0

4,000 m
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(9,842 ft) 

2,000 m
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Entering various characters
As you perform various tasks, you may need to enter names and numbers. For 
example, when you set up your machine, you enter your name or your 
company’s name, and the fax number. When you store fax numbers or email 
addresses in memory, you may also enter the corresponding names.

1 

Entering alphanumeric characters

Press the button until the correct letter appears on the display. For example, to 
enter the letter O, press 6, labeled with MNO. Each time you press 6, the display 
shows a different letter, M, N, O, m, n, o and finally 6. To find the letter that you 
want to enter, see "Keypad letters and numbers" on page 134.

 

• You can enter a space by pressing 1 twice.

• To delete the last digit or character, press the left/right or up/down arrow 
button.

 

2 

Keypad letters and numbers

Special character sets may differ from your machine depending on its options or 
the models.

Key Assigned numbers, letters, or characters

1 @ / . ‘ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

*

* % ^ _ ~ ! # $ ( ) [ ]

(These symbols are available when you type for network 
authentication.)

#

# = | ? " : { } < > ;

(These symbols are available when you type for network 
authentication.)
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3 

Registering a speed dial number

1 Select  (fax) > (Address Book) > New&Edit > Speed Dial on 
the control panel. 

2 Enter a speed dial number and press OK.

 

If an entry is already stored in the number you choose, the display shows the 
message to allow you to change it. To start over with another speed dial 

number, press  (Back). 

 

3 Enter the name you want and press OK.

4 Enter the fax number you want and press OK.

5 Press the  (Stop/Clear) button to return to ready mode.

4 

Using speed dial numbers

When you are prompted to enter a destination number while sending a fax, 
enter the speed dial number at which you stored the number you want.

 

• For a one-digit (0-9) speed dial number, press and hold the 
corresponding digit button on the number keypad for more than 2 
seconds. 

• For a two- or three-digit speed dial number, press the first digit button(s) 
and then hold down the last digit button for more than 2 seconds.

• You can print the address book list by selecting  (fax) > 

(Address Book) > Print and press OK.

 

5 

Editing speed dial numbers

1 Select  (fax) > (Address Book) > New&Edit > Speed Dial on 
the control panel. 

2 Enter the speed dial number you want to edit and press OK.

3 Change the name and press OK.

4 Change the fax number and press OK.

5 Press  (Stop/Clear) to return to ready mode.
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Registering a group dial number

1 Select  (fax) > (Address Book)> New&Edit > Group Dial on 
the control panel. 

2 Enter a group dial number and press OK.

 

If an entry is already stored in the number you choose, the display shows the 
message to allow you to change it. To start over with another speed dial 
number, press  (Back). 

 

3 Search by entering the first few letters of the speed dial’s name to put in 
the group.

4 Select the name and number you want and press OK.

5 Select Yes when Add? appears.

6 Repeat step 3 to include other speed dial numbers into the group.

7 When you have finished, select No when Another No.? appears and 
press OK.

8 Press  (Stop/Clear) to return to ready mode.

7 

Editing group dial numbers

1 Select  (fax) > (Address Book) > New&Edit > Group Dial on 
the control panel. 

2 Enter the group dial number you want to edit and press OK.

3 Enter a new speed dial number to add and press OK, then Add? appears.

Enter a speed dial number stored in the group and press OK, Delete ? 
appears.

4 Press OK to add or delete the number.

5 Repeat step 3 to add or delete more numbers.

6 Select No at the Another No.? and press OK.

7 Press  (Stop/Clear) to return to ready mode.

8 

One-touch dialing

The 20 one-touch buttons on the control panel lets you store frequently-used 
fax numbers and dial a number automatically with a touch of a button.
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Storing a number for One-touch dialing

1 Press (fax) on the control panel.

2 Press and hold one of the one-touch dial buttons for more than 2 
seconds.

If a number is already stored in the location you chose, the display shows 
the number to allow you to change it and press OK.

3 Enter the number you want to store using the number keypad and press 
OK.

To insert a pause between numbers, press (Redial/Pause). A 
symbol “-” appears on the display.

4 To assign a name to the number, enter the name you want. 

If you do not want to assign a name, skip this step.

5 Press OK when the name appears correctly or without entering a name.

6 To store more numbers, press a one-touch button and repeat steps 2 
through 5.

7 Press  (Stop/Clear) to return to ready mode.

9 

Searching Address Book for an entry

There are two ways to search for a number in memory. You can either scan from 
A to Z sequentially, or search by entering the first few letters of the name 
associated with the number.

1 Select (fax) > (Address Book) > Search&Dial > Speed Dial or 
Group Dial on the control panel. 

2 Select  All or ID and press OK.

3 Press the name, number, or the button labeled with the letter you want 
to search.

For example, if you want to find the name “MOBILE,” press “6”, which is 
labeled with the letters “MNO.”

4 Press  (Stop/Clear) to return to ready mode.

10 

Printing Address Book

You can check your Address Book settings by printing a list.



Setting up the address book

1383.  Special Features

1 Select (fax) > (Address Book) > Print on the control panel. 

2 Press OK.

The machine begins printing.
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Printing features
 

• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 46).

• This feature may not be available depending on model or optional goods 
(see "Key benefits" on page 5).

 

11 

Changing the default print settings

1 Click the Windows Start menu. 

2 Select Control Panel > Devices and Printers.

3 Right-click on your machine.

4 Select Printing preferences.

 

If Printing preferences has a , you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences. 

 

12 

Setting your machine as a default machine

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

If Printing preferences has a , you can select other printer drivers 
connected to the selected printer.
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Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• See "Features by models" on page 7.

• The XPS printer driver can be installed only on Windows Vista OS or 
higher.

• Install an optional memory when the XPS job does not print. The 
machine might be out of memory.

• For models that provide XPS driver on the software CD:

- You can install the XPS printer driver when you insert the software CD 
into your CD-ROM drive. Advanced Installation > Custom 
Installation. You can select the XPS printer driver in the Select 
Software and Utilities to Install window.

• For models that provide XPS driver from the Samsung website, 
www.samsung.com > find your product> Support or Downloads.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.

 

Understanding special printer features

You can use advanced printing features when using your machine.
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To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Click the Help ( ) button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" on page 49).

 

 

Item Description

Multiple Pages per Side Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size 
and arranged in the order you specify. You can print up to 16 pages on one sheet. 

Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic 
tab to make it easier to paste the sheets together.
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Booklet Printinga

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to 
produce a booklet.

 

• If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media. 

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to 
see what paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without 
 or  mark).

 

Double-sided Printing

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other 
page of the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

 

Item Description

8 9
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Double-sided Printing 
(continue)

Double-sided Printing 

(Manual)a

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the control panel of the 
machine. This option is available only when you use the PCL/ XPS printer driver.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or 
decrease the document.

Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Item Description
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Watermark

(Creating a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box. 
d You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 
d Click Update to save the changes.
e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Overlaya

This option is available only when you use the PCL/ SPL printer driver (see "Software" on page 7).

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay 
containing exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not 
need to load preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a 
watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Item Description
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Overlay

(Creating a new page 
overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create. 
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default 

is C:\Formover).
e Click Save. The name appears on the Overlay List. 
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Overlay

(Using a page overlay)

a Click the Advanced tab. 
b Select the desired overlay from the Text drop-down list. 
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file 

you want to use. 
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window. 
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the 
Overlay List box. 

d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit 
a document for printing, asking you to confirm printing an overlay on your document. 
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

e Click OK or Print until you exit the Print window. 

Overlay

(Deleting a page overlay)

a In the Printing Preferences window, click the Advanced tab. 
b Select Edit in the Text drop down list. 
c Select the overlay you want to delete from the Overlay List box. 
d Click Delete. 
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
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Print Mode

 

• This feature is available only if you have installed the optional memory or mass storage device (HDD) (see "Variety feature" on 
page 9).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the memory. 

- Normal: This mode prints without storing your document in the optional memory. 

- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print the rest of the copies 
later. 

- Confidential: This mode is used for printing confidential documents. You need to enter a password to print. 

- Store: Select this setting to save a document in the mass storage device (HDD) without printing. 

- Store and Print: This mode is used when printing and storing document at the same time. 

- Spool: This option can be useful when handling large amounts of data. If you select this setting, the printer spools the document 
into the mass storage device (HDD) and then prints it from the mass storage device (HDD) queue, decreasing the computer’s work 
load.

- Print Schedule: Select this setting to print the document at a specified time.

• User ID: This option is used when you need to find a saved file using the control panel. 

• Job Name: This option is used when you need to find a saved file using the control panel. 

Job Encryption

Encrypts printing data first, and transmits it to the machine. This feature protects the printing information even though the data is 
snatched on a network.

 

Job Encryption feature is enabled only when the mass storage device (HDD) is installed. The mass storage device (HDD) is used 
to decrypt the printing data.

 

a. This option is not available when you use XPS driver.

Item Description
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Macintosh printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Macintosh, you need to check the printer driver settings 
in each application you use. Follow the steps below to print from a Macintosh:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.



Printing features

1483.  Special Features

Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 9).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Macintosh application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver. 

15 

Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.
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Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open an application, and select Print from the File menu

2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your machine from the 
printer list and click Properties.

4 Change the print job properties using the following four tabs displayed 
at the top of the window.

• General: Changes the paper size, the paper type, and the 
orientation of the documents. It enables the duplex feature, adds 
start and end banners, and changes the number of pages per sheet.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing.

 

• Text: Specifies the page margins and set the text options, such as 
spacing or columns.

• Graphics: Sets image options that are used when printing image 
files, such as color options, image size, or image position.

• Advanced: Sets the print resolution, paper source, and destination.

5 Click Apply to apply the changes and close the Properties window.

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the status of your 
print job.

To abort the current job, click Cancel.

Printing files

You can print many different types of files on your machine using the standard 
CUPS, directly from the command line interface. The CUPS lpr utility allows you 
to do that, but the driver’s package replaces the standard lpr tool by a much 
more user-friendly LPR GUI program.

To print any document file:

1 Enter lpr <file_name> from the Linux shell command line and press 
Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2 In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3 Click OK to start printing.
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Configuring Printer Properties

Using the Printer Properties window provided by the Printers configuration, 
you can change the various properties for your machine as a printer.

1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click Properties.

3 The Printer Properties window appears.

The following five tabs display at the top of the window:

• General: Allows you to change the printer location and name. The 
name entered in this tab displays on the printer list in Printers 
configuration.

• Connection: Allows you to view or select another port. If you change 
the machine port from USB to parallel or vice versa while in use, you 
must re-configure the machine port in this tab.

• Driver: Allows you to view or select another machine driver. By 
clicking Options, you can set the default device options.

• Jobs: Shows the list of print jobs. Click Cancel job to cancel the 
selected job and select the Show completed jobs check box to see 
previous jobs on the job list.

• Classes: Shows the class that your machine is in. Click Add to Class 
to add your machine to a specific class or click Remove from Class 
to remove the machine from the selected class.

4 Click OK to apply the changes and close the Printer Properties window.
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Scan features
 

• For basic scanning features, refer to the Basic Guide (see "Basic Scanning" 
on page 53).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, depending 
on your system and what you are scanning, you may not be able to scan 
at certain resolutions, especially using enhanced dpi.
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Basic scanning method

 

This feature may not be available depending on model or optional goods 
(see "Variety feature" on page 9).

 

You can scan the originals with your machine via an USB cable. The following 
methodoloqies can be used for scanning your documents:

• Scan to PC: Scan the originals from the control panel. Then, the scanned 
data will be stored in the connected computers My Documents folder (see 
"Basic Scanning" on page 53).

• TWAIN: TWAIN is the one of a preset imaging applications. Scanning an 
image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection (see 
"Scanning from image editing program" on page 152).

• Samsung Scan Assistant/ SmarThru Office: You can use this program to 
scan images or documents.

- See "Scanning with Samsung Scan Assistant" on page 153.

- See "Scanning with SmarThru Office" on page 153

• WIA: WIA stands for Windows Images Acquisition. To use this feature, your 
computer must be connected directly with the machine via an USB cable 
(see "Scanning using the WIA driver" on page 152).
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Setting the scan settings in the computer

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).
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1 Open Samsung Easy Printer Manager.

2 Select the appropriate machine from the Printer List.

3 Select Scan to PC Settings menu.

4 Select the option you want.

• Scan Activation: Determines whether or not scanning is enabled on 
the device.

• Basic tab: Contains settings related to general scan and device 
settings.

• Image tab: Contains settings related to image altering.

5 Press Save > OK.
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Scanning from image editing program

You can scan and import documents at the image editing software such as 
Adobe Photoshop, if the software is TWAIN-compliant. Follow the steps below 
to scan with TWAIN-compliant software:

1 Make sure that the machine is connected to your computer and 
powered on.

2 Load originals face down into the document feeder (see "Loading 
originals" on page 44).

3 Open an application, such as Adobe Photoshop.

4 Click File > Import, and select the scanner device.

5 Set the scan options.

6 Scan and save your scanned image.
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Scanning using the WIA driver

Your machine supports the Windows Image Acquisition (WIA) driver for 
scanning images. WIA is one of the standard components provided by Microsoft 
Windows 7 and works with digital cameras and scanners. Unlike the TWAIN 
driver, the WIA driver allows you to scan and easily adjust images without using 
additional software:

 

The WIA driver works only on Windows OS (not supported Windows 2000) 
with a USB port.

 

1 Make sure that the machine is connected to your computer and 
powered on.

2 Load originals face down into the document feeder (see "Loading 
originals" on page 44).
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3 Click Start > Control Panel > Hardware and Sound > Devices and 
Printers.

4 Right-click on device driver icon in Printers and Faxes > Start Scan.

5 New Scan application appears.

6 Choose your scanning preferences and click Preview to see your 
preferences affect the picture.

7 Scan and save your scanned image.
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Scanning with Samsung Scan Assistant

 

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• You can use the OCR (Optical Character Reader) feature from Samsung 
Scan Assistant program.

 

1 Make sure that the machine is connected to your computer and 
powered on.

2 Load originals face down into the document feeder (see "Loading 
originals" on page 44).

3 Click Start > All programs > Samsung Printers, and start Samsung 
Scan Assistant.

 

Select the Help menu or click the  button from the window and click on 

any option you want to know about. 

 

4 Set the scan options.

5 Click Scan.
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Scanning with SmarThru Office

 

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

• To use SmarThru Office, you have to install the program manually from 
the supplied CD. Select Advanced Installation > Custom Installation 
and choose SmarThru Office to install.

• You can use the OCR (Optical Character Reader) feature from SmarThru 
Office program.

 



Scan features

1543.  Special Features

1 Make sure that the machine is connected to your computer and 
powered on.

2 Load originals face down into the document feeder (see "Loading 
originals" on page 44).

3 Double-click the SmarThru Office icon.

4 The SmarThru Office appears.

 

Select the Help menu or click the  button from the window and click on 

any option you want to know about. 

 

5 Click the SmarThru Office icon ( ) in the tray area of the Windows 
taskbar to activate the SmarThru Office launcher.

6 Click the scanning icon ( ) to open the scanning window.

7 The Scan Setting window opens.

8 Set scan settings and click Scan.
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Macintosh scanning

Scanning from USB connected machine

1 Make sure that the machine is connected to your computer and 
powered on.

2 Load originals face down into the document feeder (see "Loading 
originals" on page 44).

3 Start Applications and click Image Capture. 

 

If No Image Capture device connected message appears, disconnect the 
USB cable and reconnect it. If the problem continues, refer to the Image 
Capture’s help.

 

4 Select the option you want. 

5 Scan and save your scanned image.

 

If scanning does not operate in Image Capture, update Mac OS to the latest 
version. Image Capture operates properly in Mac OS X 10.4.7 or higher.
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Linux scanning

Scanning

1 Make sure that the machine is connected to your computer and 
powered on.

2 Double-click the Unified Driver Configurator on your desktop. 

3 Click the  button to switch to Scanners Configuration. 

4 Select the scanner on the list.

5 Click Properties. 

6 Place a single document face down on the document glass, or load the 
documents face up into the ADF.

7 From the Scanner Properties window, click Preview.

8 The document is scanned and the image preview appears in the 
Preview Pane.

9 Drag the pointer to set the image area to be scanned in the Preview 
Pane.

10 Select the option you want. 
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11 Scan and save your scanned image.

 

For later use, you can save as your scan settings and add it to the Job Type 
drop-down list. 

 

Editing an image with Image Manager

The Image Manager application provides you with menu commands and tools 
to edit your scanned image.
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Fax features
 

• For basic scanning features, refer to the Basic Guide (see "Basic faxing" on 
page 68).

• This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).
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Automatic redialing

When the number you have dialed is busy or there is no answer when you send 
a fax, the machine automatically redials the number. The redial time depends on 
the country's factory default setting.

When the display shows Retry Redial?, press (Start) button to redial the 

number without waiting. To cancel the automatic redialing, press (Stop/

Clear). 

To change the time interval between redials and the number of redial attempts.

1 Press  (fax) > (Menu) > Fax Setup > Sending on the control 
panel.

2 Select Redial Times or Redial Term you want.

3 Select the option you want.
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Redialing the fax number

1 Press (Redial/Pause) on the control panel. 

2 Select the fax number you want.

Ten recently sent fax numbers with ten received caller IDs are shown.

3 When an original is loaded in the document feeder, the machine 
automatically begins to send.
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Confirming a transmission

When the last page of your original has been sent successfully, the machine 
beeps and returns to ready mode.

When something goes wrong while sending your fax, an error message appears 

on the display. If you receive an error message, press (Stop/Clear) to clear 

the message and try to send the fax again.

 

You can set your machine to print a confirmation report automatically each 

time sending a fax is completed. Press  (fax) > (Menu) > Fax 

Setup > Sending > Send Report on the control panel.
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Sending a fax in the computer

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

You can send a fax from your computer without going to the machine.

To send a fax from your computer, the Samsung Network PC Fax program 
must be installed. This program will be installed when you installed the printer 
driver. 

1 Open the document to be sent.

2 Select Print from the File menu. 

The Print window will be displayed. It may look slightly different 
depending on your application.

3 Select Samsung Network PC Fax from the Print window

4 Click Print or OK.

5 Enter the recipients’ numbers and select the option

 

Select the Help menu or click the  button from the window and click on 
any option you want to know about. 

 

6 Click Send.
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Delaying a fax transmission

You can set your machine to send a fax at a later time when you will not be 
present. You cannot send a color fax using this feature.
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1 Load the documents face down into the document feeder.

2 Press  (fax) on the control panel.

3 Adjust the resolution and the darkness to suit your fax needs.

4 Press (Menu) > Fax Feature > Delay Send on the control panel.

You also can use Delay Send button directly on the control panel.

5 Enter the number of the receiving fax machine and press OK.

6 The display asks you to enter another fax number to send the document.

7 To enter more fax numbers, press OK when Yes highlights and repeat 
steps 5.

 

• You can add up to 10 destinations.

• Once you entered a group dial number, you cannot enter another group 
dial numbers anymore.

 

8 Enter the job name and the time.

 

If you set a time earlier than the current time, the fax will be sent at that time 
on the following day.

 

9 The original is scanned into memory before transmission.

The display reminds you that you are in ready mode and that a delayed 
fax is set. The machine returns to ready mode. 

 

You can check the list of delayed fax jobs.

Press (Menu) > System Setup > Report > Schedule Jobs on the 

control panel.

 

Adding documents to a reserved fax

1 Load the documents face down into the document feeder.

2 Press  (fax) > (Menu) > Fax Feature > Add Page on the control 
panel.

3 Select the fax job and press OK.

4 Press  (Stop/Clear) to return to ready mode.

Canceling a reserved fax job

1 Press  (fax)> (Menu > Fax Feature > Cancel Job on the control 
panel.

2 Select the fax job you want and press OK.
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3 Press OK when Yes highlights.

The selected fax is deleted from memory.

4 Press (Stop/Clear) to return to ready mode.
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Sending a priority fax

This function is used when a high priority fax need to be sent ahead of reserved 
operations. The original is scanned into memory and immediately transmitted 
when the current operation is finished.

1 Load the documents face down into the document feeder.

2 Press  (fax) > (Menu) > Fax Feature > Priority Send on the 
control panel.

3 Enter the destination fax number and press OK.

4 Enter the job name and press OK.

5 Press (Stop/Clear)to return to ready mode.
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Forwarding a sent fax to another destination

You can set the machine to forward the received or sent fax to other destination 
by a fax or PC. If you are out of office but have to receive the fax, this feature may 
be useful.

 

Though you sent or received a color fax, the data is forwarded in grayscale.

 

1 Load the documents face down into the document feeder.

2 Press  (fax) > (Menu) > Fax Feature > Forward > Fax > Send 
Forward > On on the control panel.

3 Enter the destination fax number press OK.

4 Press (Stop/Clear)to return to ready mode.

Subsequent sent faxes will be forwarded to the specified fax machine.
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Forwarding a received fax

 

Though you sent or received a color fax, the data is forwarded in grayscale.
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You can set the machine to forward the received or sent fax to other destination 
by a fax or PC. If you are out of office but have to receive the fax, this feature may 
be useful.

1 Load the documents face down into the document feeder.

2 Press  (fax) > (Menu) > Fax Feature > Forward > Fax > RCV 
Forward on the control panel.

3 Select Forward or Forward&Print and press OK.

 

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward&Print. 

 

4 Enter the destination fax number or PC and press OK.

5 Enter the time to start and stop forwarding and press OK.

6 Press (Stop/Clear) to return to ready mode.

Subsequent received faxes will be forwarded to the specified fax 
machine.
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Receiving a fax in the computer

 

• Samsung Easy Printer Manager is Available for Windows and Macintosh 
OS users only.

• To use this feature, set the option on the control panel: Press  (fax) 

> (Menu) > Fax Feature > Forward > PC > On on the control panel.

 

1 Open the Samsung Easy Printer Manager.

2 Select the appropriate machine from the Printer List.

3 Select Fax to PC Settings menu.

4 Use Enable Fax Receiving from Device to change the fax settings.

• Image Type: Convert the received faxes to PDF or TIFF.

• Save Location: Select location to save the converted faxes.

• Prefix: Select prefix. 

• Print received fax: After receiving the fax, set prints information for 
the received fax.

• Notify me when complete:  Set to show the popup window to 
notify receiving a fax.
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• Open with default application:  After receiving the fax, open it with 
default application.

• None:  After receiving a fax, the machine does not notify the user or 
opens the application.

5 Press Save > OK.
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Changing the receive modes

1 Press  (fax) > (Menu) > Fax Setup > Receiving > Receive 
Mode on the control panel.

You also can use Receive Mode button directly on the control panel.

2 Select the option you want. 

• Fax: Answers an incoming fax call and immediately goes into the fax 
reception mode.

• Tel: Receives a fax by pressing  (On Hook Dial) and then 

(Start).

• Ans/Fax: Is for when an answering machine attached to your 
machine. Your machine answers an incoming call, and the caller can 
leave a message on the answering machine. If the fax machine 
senses a fax tone on the line, the machine automatically switches to 
Fax mode to receive the fax.

 

To use the Ans/Fax mode, attach an answering machine to the EXT socket 
on the back of your machine. 

 

• DRPD: you can receive a call using the Distinctive Ring Pattern 
Detection (DRPD) feature. Distinctive Ring is a telephone company 
service which enables an user to use a single telephone line to 
answer several different telephone numbers. For further details, see 
"Receiving faxes using DRPD mode" on page 163.

 

This setting may not be available depending on your country. 

 

3 Press OK.

4 Press (Stop/Clear) to return to ready mode.
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Receiving manually in Tel mode

You can receive a fax call by pressing  (On Hook Dial) and then pressing 

(Start) when you hear a fax tone. If your machine has a handset, you can 

answer calls using the handset.
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Receiving in Answering Machine/Fax mode

To use this mode, you must attach an answering machine to the EXT socket on 
the back of your machine. If the caller leaves a message, the answering machine 
stores the message. If your machine detects a fax tone on the line, it 
automatically starts to receive the fax.

 

• If you have set your machine to this mode and your answering machine 
is switched off, or no answering machine is connected to EXT socket, 
your machine automatically goes into Fax mode after a predefined 
number of rings.

• If the answering machine has a user-selectable ring counter, set the 
machine to answer incoming calls within 1 ring.

• If the machine is in Tel mode, disconnect or switch off the answering 
machine with the fax machine. Otherwise, the outgoing message from 
the answering machine will interrupt your phone conversation.
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Receiving faxes with an extension telephone

When you are using an extension telephone connected to the EXT socket, you 
can receive a fax from someone you are talking to on the extension telephone, 
without going to the fax machine.

When you receive a call on the extension phone and hear fax tones, press the 
keys *9* on the extension phone. The machine receives the fax.

*9* is the remote receive code preset at the factory. The first and the last 
asterisks are fixed, but you can change the middle number to whatever you 
want.

 

While you are talking over the telephone connected to the EXT socket, copy 
and scan features are not available.
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Receiving faxes using DRPD mode

Distinctive Ring is a telephone company service which enables an user to use a 
single telephone line to answer several different telephone numbers. This 
feature is often used by answering services who answer telephones for many 
different clients and need to know which number someone is calling in on to 
properly answer the phone.

 

This setting may not be available depending on your country.

 

1 Select  (fax) > (Menu) > Fax Setup > Receiving > DRPD Mode 
on the control panel. 

2 Call your fax number from another telephone. 
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3 When your machine begins to ring, do not answer the call. The machine 
requires several rings to learn the pattern.

When the machine completes learning, the display shows Completed 
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears.

4 Press OK when DRPD appears and start over from step 2.

 

• DRPD must be set up again if you re-assign your fax number, or connect 
the machine to another telephone line.

• After DRPD has been set up, call your fax number again to verify that the 
machine answers with a fax tone. Then have a call placed to a different 
number assigned to that same line to be sure the call is forwarded to the 
extension telephone or answering machine plugged into the EXT socket.
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Receiving in secure receiving mode

 

This feature may not be available depending on model or optional goods 
(see "Features by models" on page 7).

 

You may need to prevent your received faxes from being accessed by 
unauthorized people. Turn on secure receiving mode, then all incoming faxes 
go into memory. You can print the incoming faxes with entering the password. 

 

To use the secure receiving mode, activate the menu from  (fax) > 

(Menu) > Fax Feature > Secure Receive > On on the control panel. 

 

Printing received faxes

1 Select  (fax) > (Menu) > Fax Feature > Secure Receive > Print 
on the control panel. 

2 Enter a four-digit password and press OK. 

3 The machine prints all of the faxes stored in memory.
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Receiving faxes in memory

Since your machine is a multi-tasking device, it can receive faxes while you are 
making copies or printing. If you receive a fax while you are copying or printing, 
your machine stores incoming faxes in its memory. Then, as soon as you finish 
copying or printing, the machine automatically prints the fax. 

 

If fax is received and being printed, other copy and print jobs cannot be 
processed at the same time.
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Printing sent fax report automatically

You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.

1 Press  (fax) > (Menu) > Fax Setup > Auto Report > On on the 
control panel.

2 Press (Stop/Clear) to return to ready mode.



4. Useful Management 
Tools

This chapter introduces management tools provided to help you make full use of your machine. 

• Easy Capture Manager 167
• Samsung AnyWeb Print 168
• Easy Eco Driver 169
• Using Samsung Easy Printer Manager 170
• Using Samsung Printer Status 173
• Using Smart Panel 175
• Using the Linux Unified Driver Configurator 177
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Easy Capture Manager
 

• Available for Windows OS users only.

• This feature may not be available depending on model or optional goods (see "Features by models" on page 7).

 

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key. Now you can easily print your captured screen as captured or edited.
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Samsung AnyWeb Print
 

• Available for Windows and Macintosh OS users only.

• This feature may not be available depending on model or optional goods (see "Features by models" on page 7).

 

This tool helps you screen-capture, preview, scrap, and print Windows Internet Explorer pages more easily, than when you use an ordinary program. Click Start > All 
programs > Samsung Printers > Samsung AnyWeb Print > Download the latest version to link to the website where the tool is available for download.
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Easy Eco Driver
 

• Available for Windows OS users only.

• This feature may not be available depending on model or optional goods (see "Features by models" on page 7).

 

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing. To use this application, Start Easy Eco Driver before printing job 
checkbox in the printer properties should be checked. 

Easy Eco Driver also allows you simple editing such as removing images and texts, changing fonts, and more. You can save frequently used settings as a preset.

How to use: 

1 Open a document to print.

2 Print the document.

A preview window appears.

3 Select the options you want to apply to the document.

You can see the preview of the applied features.

4 Click Print.
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Using Samsung Easy Printer Manager 
 

• Available for Windows and Macintosh OS users only.

• This feature may not be available depending on model or optional goods 
(see "Software" on page 7).

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Samsung Easy Printer Manager is an application that combines Samsung 
machine settings into one location. Samsung Easy Printer Manager combines 
device settings as well as printing environments, settings/actions and 
launching. All of these features provide a gateway to conveniently use your 
Samsung machine. Samsung Easy Printer Manager provides two different user 
interfaces for the user to choose from: the basic user interface and the advanced 
user interface. Switching between the two interfaces is easy: just click a button.

1 

Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Easy Printer Manager > Samsung Easy Printer Manager.

For Macintosh,

Open the Applications folder > Samsung folder > Samsung Easy Printer 
Manager.

The Samsung Easy Printer Manager interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer List displays the installed printer icons on your 

computer and network printer added by network 
discovery (Windows only).
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Select the Help menu or click the  button from the window and click on 

any option you want to know about. 

 

2 

Advanced settings user interface overview

The advanced user interface is intended to be used by the person responsible 
for managing the network and machines.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

 

2

Printer 
information

This area gives you general information about your 
machine. You can check information, such as the machine’s 
model name, IP address (or Port name), and machine 
status.

 

You can view the online User’s Guide.

Troubleshooting Guide  button: This button 
opens the Troubleshooting Guide when an error 
occurs. You can directly open the section in the 
user’s guide.

 

3

Application 
information

Includes links for changing to the advanced settings, 
preference, help, and about.

 

The  button is used to change the user 
interface to the advanced settings user interface 
(see "Advanced settings user interface overview" 
on page 171).

 

4
Quick links Displays Quick links to machine specific functions. This 

section also includes links to applications in the advanced 
settings.

5

Contents area Displays information about the selected machine, 
remaining toner level, and paper. The information will vary 
based on the machine selected. Some machines do not 
have this feature.

6
Order supplies Click on the Order button from the supply ordering 

window. You can order replacement toner cartridge(s) 
from online.
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Device Settings

You can configure various machine settings such as machine setup, paper 
option, layout, Copy, Fax setting, Address book and print information.

Scan to PC Settings

This menu includes settings to create or delete scan to PC profiles. 

• Scan Activation: Determines whether or not scanning is enabled on the 
device.

• Basic tab:  Contains settings related general scan and device settings.

• Image tab:  Contains settings related to image altering.

Fax to PC Settings

This menu includes settings related to the basic fax functionality of the selected 
device. 

• Disable: If Disable is On, incoming faxes will not be received on this device.

• Enable Fax Receiving from Device: Enables faxing on the device and allow 
more options to be set.

Alert Settings (Windows only)

This menu includes settings related to error alerting. 

• Printer Alert: Provides settings related to when alerts will be received.

• Email Alert: Provides options relating to receiving alerts via email.

• Alert History:  Provides a history of device and toner related alerts.
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Using Samsung Printer Status 
The Samsung Printer Status is a program that monitors and informs you of the 
machine status. 

 

• Available for Windows OS users only (see "Features by models" on page 
7).

• The Samsung Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "Specifications" on page 92).
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Samsung Printer Status overview

If an error occurs while operating, you can check the error from the Samsung 
Printer Status. Samsung Printer Status is installed automatically when you install 
the machine software. 

You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might occur in 
the future. For example, it might be in toner low status, 
which may lead to toner empty status. 

Error The machine has at least one error.

1

Toner Level You can view the level of toner remaining in each 
toner cartridge. The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines do 
not have this feature.

2 Option You can set printing job alert related settings.
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3
Order Supplies You can order replacement toner cartridge(s) from 

online.

4

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting 
Guide when an error occurs. You can directly 
open the troubleshooting section in the user’s 
guide. 

 

5 Close Close the window.
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Using Smart Panel
Smart Panel is a program that monitors and informs you of the machine’s status, 
and allows you to customize the machine’s settings. You can download Smart 
Panel from the Samsung website (see "Installing the Smart Panel" on page 116).

 

• Available for Linux OS users only (see "Features by models" on page 7).

• The Smart Panel window and its contents shown in this user’s guide may 
differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "Specifications" on page 92).

 

4 

Smart Panel overview

If an error occurs while operating, you can check the error from the Smart Panel. 
You can also launch Smart Panel manually.

Double-click the Smart Panel icon( ) in the Notification Area.

1

 2

3

4

1

Toner Level You can view the level of toner remaining in each toner 
cartridge. The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. If you cannot see 
this feature, it is not applicable to your machine.

2
Buy Now You can order replacement toner cartridge(s) from 

online.

3

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting 
Guide when an error occurs. You can directly 
open the troubleshooting section in the user’s 
guide. 

 

4

Printer Setting You can configure various machine settings in the 
Printer Settings Utility window. Some machines do not 
have this feature.

 

If you connect your machine to a network, the 
SyncThru™ Web Service window appears 
instead of the Printer Settings Utility.
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5 

Changing Smart Panel’s settings

Right-click in Linux on the Smart Panel icon and select Configure smart panel. 
Select the settings you want from the Configure smart panel window. 



1774.  Useful Management Tools

Using the Linux Unified Driver Configurator
The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified Driver 
Configurator (see "Installation for Linux" on page 116).

After the driver is installed on your Linux system, the Unified Driver Configurator 
icon will automatically be created on your desktop.

6 

Opening Unified Driver Configurator

1 Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2 Click each button on the left to switch to the corresponding 
configuration window.

1 Printer Configuration 
2 Port Configuration 

 

 To use the on screen help, the Help or  button from the window.
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3 After changing the configurations, click Exit to close the Unified Driver 
Configurator.

7 

Printers configuration

Printers configuration has the two tabs: Printers and Classes.

Printers tab

View the current system’s printer configuration by clicking on the machine icon 
button on the left side of the Unified Driver Configurator window.

The printer control buttons are, as follows:

• Refresh: Renews the available machines list.

• Add Printer: Allows you to add a new machines.

• Remove Printer: Removes the selected machine.

• Set as Default: Sets the current selected machine as a default machine.

• Stop/Start: Stops/starts the machine.

• Test: Allows you to print a test page to ensure the machine is working 
properly.

• Properties: Allows you to view and change the printer’s properties. 

1 Switches to Printers configuration.

2 Shows all of the installed machines.

3 Shows the status, model name, and URI of your machine.
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Classes tab

The Classes tab shows a list of available machine classes.

• Refresh: Renews the classes list.

• Add Class: Allows you to add a new machine class.

• Remove Class: Removes the selected machine class.

8 

Ports configuration

In this window, you can view the list of available ports, check the status of each 
port and release a port that is stalled in a busy state when its owner has 
terminated the job for any reason.

• Refresh: Renews the available ports list.

• Release port: Releases the selected port.

1 Shows all of the machine classes.

2
Shows the status of the class and the number of machines 
in the class.

1 Switches to Ports configuration.

2 Shows all of the available ports.

3
Shows the port type, device connected to the port, and 
status.
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• Paper feeding problems 181
• Power and cable connecting problems 182
• Printing problems 183
• Printing quality problems 187
• Copying problems 195
• Scanning problems 196
• Faxing problems 198
• Operating system problems 200



1815.  Troubleshooting

Paper feeding problems

Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, use the 
multi-purpose tray (or manual feeder).

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the front cover and remove any debris.

Envelopes skew or fail to feed correctly. Ensure that the paper guides are against both sides of the envelopes.



1825.  Troubleshooting

Power and cable connecting problems

 Click this link to open an animation about solving power problems.

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

• Connect the machine to the electricity supply first. If the machine has a  (Power) button on the control, press it. 

• Disconnect the machine’s cable and reconnect it.
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Printing problems
 

Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Connect the machine to the electricity supply first. If the machine has a  (Power) 

button on the control, press it. 

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The cover is not closed. Close the cover.

• Paper is jammed. Clear the paper jam.

• No paper is loaded. Load paper.

• The toner cartridge is not installed. Install the toner cartridge.

• Make sure the protect cover and sheets are removed from the toner cartridge.

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 22).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.
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The machine does not 
print.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 
materials from the wrong 
paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening printing preferences" on page 48). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 49).

A print job is extremely 
slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening printing preferences" on 
page 48). See the printer driver help screen (see "Using help" on page 49).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.

Or, ensure that the paper size in the printer driver settings matches the paper selection 
in the software application settings you use (see "Opening printing preferences" on 
page 48).

Condition Possible cause Suggested solutions
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The machine prints, but 
the text is wrong, 
garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

The wrong printer driver was selected. Check the application’s printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 
blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

• see "Redistributing toner" on page 64.

• see "Replacing the toner cartridge" on page 66.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 
print PDF files correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Condition Possible cause Suggested solutions
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Before printing, the 
machine emits vapor near 
the output tray.

Using damp paper can cause vapor during 
printing.

This is not a problem. Just keep printing.

The machine does not 
print special-sized paper, 
such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening printing preferences" on page 48).

The printed billing paper 
is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thick (see "Opening printing preferences" on page 48).

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 66).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 70).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
70). If these steps do not correct the problem, contact a service representative.

The top half of the 
paper is printed lighter 
than the rest of the 
paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 48).
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Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 70).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 70).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick (see "Opening 
printing preferences" on page 48).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 70).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 70).

If these steps do not correct the problem, contact a service representative.

Condition Suggested solutions

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C
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Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the toner cartridge inside the machine has probably been scratched. Remove the toner cartridge and 
install a new one (see "Replacing the toner cartridge" on page 66).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
70). If these steps do not correct the problem, contact a service representative.

Black or color 
background

If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old toner cartridge and install a new one (see "Replacing the toner cartridge" on page 66).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 64).

Toner smear • Clean the inside of the machine (see "Cleaning the machine" on page 70).

• Check the paper type and quality.

• Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on page 66). 

Condition Suggested solutions
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Vertical repetitive 
defects

If marks repeatedly appear on the printed side of the page at even intervals:

• The toner cartridge may be damaged. If you still have the same problem, remove the toner cartridge and, install a new one (see 
"Replacing the toner cartridge" on page 66).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams 
on the reverse side. Printing on seams can cause problems.
Or select Thick Envelope from the Printing Preferences window (see Basic Guide).

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences. Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper 
actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 64). 

Condition Suggested solutions

A
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Toner particles are 
around bold 
characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening printing preferences" on page 48).

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, an overcharging 
can occur causing this copy quality problem.

Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Condition Suggested solutions

A a B b CA a B b CA a B b CA a B b CA a B b C c
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Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are 
dirty

• Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 70).

Condition Suggested solutions
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Solid color or black 
pages

• The toner cartridge may not be installed properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 66).

• The machine may require repairing. Contact a service representative.

Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 70).

• Check the paper type and quality.

• Remove the toner cartridge and then, install a new one (see "Replacing the toner cartridge" on page 66).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Condition Suggested solutions

A

A
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Horizontal stripes If horizontally aligned black streaks or smears appear:

• The toner cartridge may be installed improperly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. Remove the toner cartridge and install a new one (see "Replacing the toner cartridge" on 
page 66).

If the problem persists, the machine may require repairing. Contact a service representative.

Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening printing preferences" on page 48).

• An unknown image 
repetitively appears 
on a few sheets

• Loose toner

• Light print or 
contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for your machine (See 
"Altitude adjustment" on page 133).

Condition Suggested solutions
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Copying problems

Condition Suggested solutions

Copies are too light or too dark. Adjust the darkness in copy feature to lighten or darken the backgrounds of copies (see "Changing the settings for each copy" on page 
50).

Smears, lines, marks, or spots 
appear on copies.

• If the defects are on the original, adjust darkness in copy feature to lighten the background of your copies.

• If there are no defects on the original, clean the scan unit (see "Cleaning the scan unit" on page 74).

Copy image is skewed. • Ensure that the original is aligned with the registration guide.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 70).

Blank copies print out. Ensure that the original is face down in the document feeder.

If these steps do not correct the problem, contact a service representative.

Image rubs off the copy easily. • Replace the paper in the tray with paper from a new package.

• In high humidity areas, do not leave paper in the machine for extended periods of time.

Frequent copy paper jams 
occur.

• Fan the paper, then turn it over in the tray. Replace the paper in the tray with a fresh supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper type and weight.

• Check for copy paper or pieces of copy paper remaining in the machine after a paper jam has been cleared.

Toner cartridge produces fewer 
copies than expected before 
running out of toner.

• Your originals may contain pictures, solids, or heavy lines. For example, your originals may be forms, newsletters, books, or other 
documents that use more toner.

• Turn the machine off and back on.
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Scanning problems

Condition Suggested solutions

The scanner does not work. • Make sure that you place the original to be scanned face down in the document feeder (see "Loading originals" on page 44).

• There may not be enough available memory to hold the document you want to scan. Try the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine printer cable is connected properly.

• Make sure that the machine printer cable is not defective. Switch the printer cable with a known good cable. If necessary, replace 
the printer cable.

• Check that the scanner is configured correctly. Check scan setting in the SmarThru Office or the application you want to use to make 
certain that the scanner job is being sent to the correct port (for example, USB001).

The unit scans very slowly. • Check if the machine is printing received data. If so, scan the document after the received data has been printed.

• Graphics are scanned more slowly than text.

• Communication speed slows in scan mode because of the large amount of memory required to analyze and reproduce the scanned 
image. Set your computer to the ECP printer mode through BIOS setting. It will help to increase the speed. For details about how 
to set BIOS, refer to your computer user’s guide.
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Message appears on your 
computer screen:

• Device can’t be set to the H/W 
mode you want.

• Port is being used by another 
program.

• Port is disabled.

• Scanner is busy receiving or 
printing data. When the 
current job is completed, try 
again.

• Invalid handle.

• Scanning has failed.

• There may be a copying or printing job in progress. Try your job again when that job is finished.

• The selected port is currently being used. Restart your computer and try again.

• The machine printer cable may be improperly connected or the power may be off.

• The scanner driver is not installed or the operating environment is not set up properly.

• Ensure that the machine is properly connected and the power is on, then restart your computer.

• The USB cable may be improperly connected or the power may be off.

Condition Suggested solutions
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Faxing problems

Condition Suggested solutions

The machine is not working, 
there is no display, or the 
buttons are not working.

• Unplug the power cord and plug it in again.

• Ensure that there is power being supplied to the electrical outlet.

• Ensure that the power switch is turned on, and the soft power switch on the control panel is pressed.

No dial tone. • Check that the phone line is properly connected (see "Rear view" on page 22).

• Check that the phone socket on the wall is working by plugging in another phone.

The numbers stored in memory 
do not dial correctly.

Make sure that the numbers are stored in memory correctly. To check that, print an address book list.

The original does not feed into 
the machine.

• Make sure that the paper is not wrinkled and you are inserting it in correctly. Check that the original is the right size, not too thick 
or thin.

• Make sure that the document feeder is firmly closed.

• The document feeder rubber pad may need to be replaced. Contact a service representative (see "Available maintenance parts" on 
page 61).

Faxes are not received 
automatically.

• The receiving mode should be set to fax (see "Changing the receive modes" on page 162).

• Make sure that there is paper in the tray (see "Print media specifications" on page 94).

• Check to see if the display shows any error message. If it does, clear the problem.

The machine does not send. • Make sure that the original is loaded in the document feeder.

• Check the fax machine you are sending to, to see if it can receive your fax.

The incoming fax has blank 
spaces or is of poor-quality.

• The fax machine sending you the fax may be faulty.

• A noisy phone line can cause line errors.

• Check your machine by making a copy.

• A toner cartridge has almost reached its estimated cartridge life. Replace the toner cartridge ("Replacing the toner cartridge" on 
page 66).
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Some of the words on an 
incoming fax are stretched.

The fax machine sending the fax had a temporary document jam. 

There are lines on the originals 
you sent.

Check your scan unit for marks and clean it (see "Cleaning the scan unit" on page 74).

The machine dials a number, 
but the connection with the 
other fax machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming calls. Speak with the other machine operator and 
ask them to solve the problem on their side.

Faxes do not store in memory. There may not be enough memory space to store the fax. If the display indicating the memory status shows, delete any faxes you no 
longer need from the memory, and then try to store the fax again. Call for service.

Blank areas appear at the 
bottom of each page or on 
other pages, with a small strip 
of text at the top.

You may have chosen the wrong paper settings in the user option setting. Check the paper size and type again.

Condition Suggested solutions
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Operating system problems
1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 
“Exception OE”, “Spool 32”, or 
“Illegal Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.
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2 

Common Macintosh problems

 

Refer to the Macintosh User’s Guide that came with your computer for further information on Macintosh error messages.

 

Condition Suggested solutions

The machine does not print PDF files 
correctly. Some parts of graphics, text, or 
illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Macintosh 
with Acrobat Reader 6.0 or higher, colors 
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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3 

Common Linux problems

 

Condition Suggested solutions

The machine does not print. • Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the Printers tab in the 
Printers configuration window to look at the list of available machines. Make sure that your machine is displayed on the list. If 
not, open Add new printer wizard to set up your device.

• Check if the machine is started. Open Printers configuration and select your machine from the printers list. Look at the 
description in the Selected printer pane. If its status contains Stopped, press the Start button. Normal operation of the machine 
should be restored. The “stopped” status might be activated when some problems in printing occur. 

• Check if your application has special print options such as “-oraw”. If “-oraw” is specified in the command line parameter, then 
remove it to print properly. For Gimp front-end, select “print” -> “Setup printer” and edit the command line parameter in the 
command item.

Some color images come out all 
black.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.05) when the base color space of the document is indexed color 
space and it is converted through CIE color space. Because Postscript uses CIE color space for Color Matching System, you should 
upgrade Ghostscript on your system to at least GNU Ghostscript version 7.06 or later. You can find recent Ghostscript versions at 
www.ghostscript.com.

Some color images come out in 
unexpected color.

This is a known bug in Ghostscript (until GNU Ghostscript version 7.xx) when the base color space of the document is indexed RGB 
color space and it is converted through CIE color space. Because Postscript uses CIE color space for Color Matching System, you 
should upgrade Ghostscript on your system to at least GNU Ghostscript version 8.xx or later. You can find recent Ghostscript versions 
at www.ghostscript.com.

The machine does not print 
whole pages, and output is 
printed on half the page.

It is a known problem that occurs when a color machine is used on version 8.51 or earlier of Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript Bug 688252.The problem is solved in AFPL Ghostscript v. 8.52 or above. Download 
the latest version of AFPL Ghostscript from http://sourceforge.net/projects/ghostscript/ and install it to solve this problem.



Operating system problems

2035.  Troubleshooting

 

I cannot scan via Gimp Front-
end.

Check if Gimp Front-end has Xsane:Device dialog. on the Acquire menu. If not, you should install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package for Gimp on Linux distribution CD or Gimp home page. For the detailed information, 
refer to the Help for Linux distribution CD or Gimp Front-end application. 

If you wish to use another kind of scan application, refer to application’s Help.

“Cannot open port device file” 
error message appears when 
printing a document.

Avoid changing print job parameters (e.q., via LPR GUI) while a print job is in progress. Known versions of CUPS server break the print 
job whenever print options are changed and then try to restart the job from the beginning. Since Unified Linux Driver locks the port 
while printing, the abrupt termination of the driver keeps the port locked and unavailable for subsequent print jobs. If this situation 
occurs, try to release the port by selecting Release port in the Port configuration window.

The machine does not appear 
on the scanners list.

• Ensure your machine is attached to your computer, connected properly via the USB port, and is turned on.

• Ensure the scanner driver for your machine is installed in your system. Open Unified Linux Driver configurator, switch to Scanners 
configuration, then press Drivers. Make sure that driver with a name corresponding to your machine's name is listed in the 
window. 

• Ensure the port is not busy. Since functional components of machine (printer and scanner) share the same I/O interface (port), the 
situation of simultaneous access of different user applications to the same port is possible. To avoid possible conflicts, only one of 
them at a time is allowed to gain control over the device. The other user will encounter “device busy” response. This usually 
happens when starting a scan procedure. An appropriate message box appears.
To identify the source of the problem, open the Ports configuration and select the port assigned to your scanner, port's symbol /
dev/mfp0 corresponds to LP:0 designation displayed in the scanners’ options, /dev/mfp1 relates to LP:1, and so on. USB ports start 
at /dev/mfp4, so scanner on USB:0 relates to /dev/mfp4 respectively and so forth sequentially. In the Selected port pane, you can 
see if the port is occupied by another application. If this is the case, you should either wait for completion of the current job or 
press the Release port button, if you are sure that the present port application is not functioning properly.

The machine does not scan. • Ensure a document is loaded into the machine, ensure your machine is connected to the computer.

• If there is an I/O error while scanning.

Condition Suggested solutions
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Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

4 

Common PostScript problems

The following situations are PS language specific and may occur when several printer languages are used.

 

 

Problem Possible cause Solution

The PostScript file cannot be 
printed

The PostScript driver may not be installed 
correctly.

• Install the PostScript driver (see "Software Installation" on page 113).

• Print a configuration page and verify that the PS version is available for 
printing.

• If the problem persists, contact a service representative.

Limit Check Error report prints The print job was too complex. You might need to reduce the complexity of the page or install more memory.

A PostScript error page prints The print job may not be PostScript. Make sure that the print job is a PostScript job. Check to see whether the software 
application expected a setup or PostScript header file to be sent to the machine.

The optional tray is not 
selected in the driver

The printer driver has not been configured to 
recognize the optional tray.

Open the PostScript driver properties, select the Device Options tab, and set the 
tray option.

When printing a document in 
Macintosh with Acrobat Reader 
6.0 or higher, colors print 
incorrectly

The resolution setting in the printer driver may 
not be matched with the one in Acrobat Reader.

Make sure that the resolution setting in your printer driver matches the one in 
Acrobat Reader.
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Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung products, contact 
the Samsung customer care center.

Country/Region Customer Care Center Web Site

ALBANIA 42 27 5755 www.samsung.com

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555 www.samsung.com

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA
0810-SAMSUNG (7267864, € 
0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555 www.samsung.com

BAHRAIN 8000-4726 www.samsung.com

BELARUS 810-800-500-55-500 www.samsung.com

BELGIUM

02-201-24-18 www.samsung.com/be 
(Dutch)

www.samsung.com/
be_fr (French)

BOLIVIA 800-10-7260 www.samsung.com

BOSNIA 05 133 1999 www.samsung.com

BRAZIL
0800-124-421

4004-0000

www.samsung.com

BULGARIA 07001 33 11 www.samsung.com

CAMEROON 7095-0077 www.samsung.com

CANADA

1-800-SAMSUNG (726-7864) www.samsung.com/ca

www.samsung.com/
ca_fr (French)

CHILE
800-SAMSUNG (726-7864)

From mobile 02-482 82 00

www.samsung.com

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

COTE D’LVOIRE 8000 0077 www.samsung.com

CROATIA 062 SAMSUNG (062 726 7864) www.samsung.com

CYPRUS 8009 4000 only from landline www.samsung.com

CZECH REPUBLIC

800-SAMSUNG (800-726786) www.samsung.com

Samsung Electronics Czech and Slovak, s.r.o., Oasis Florenc, 
Sokolovská 394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 08000-726786 www.samsung.com

Country/Region Customer Care Center Web Site
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EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY
01805 - SAMSUNG (726-7864 € 
0,14/min)

www.samsung.com

GEORGIA 8-800-555-555 www.samsung.com

GHANA
0800-10077

0302-200077

www.samsung.com

GREECE

80111-SAMSUNG (80111 726 
7864) only from land line

(+30) 210 6897691 from mobile 
and  land line

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-27919267 www.samsung.com

HONG KONG

(852) 3698-4698 www.samsung.com/hk

www.samsung.com/
hk_en/

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

INDIA

1800 1100 11

3030 8282

1800 3000 8282

1800 266 8282

www.samsung.com

INDONESIA
0800-112-8888

021-5699-7777

www.samsung.com

IRAN 021-8255 www.samsung.com

ITALY 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 (GSM:7799) www.samsung.com

KENYA 0800 724 000 www.samsung.com

KOSOVO +381 0113216899 www.samsung.com

KUWAIT 183-2255 www.samsung.com

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

Country/Region Customer Care Center Web Site
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MALAYSIA 1800-88-9999 www.samsung.com

MACEDONIA 023 207 777 www.samsung.com

MEXICO 01-800-SAMSUNG (726-7864) www.samsung.com

MOLDOVA 00-800-500-55-500 www.samsung.com

MONGOLIA www.samsung.com

MONTENEGRO 020 405 888 www.samsung.com

MOROCCO 080 100 2255 www.samsung.com

NIGERIA 0800-726-7864 www.samsung.com

NETHERLANDS
0900-SAMSUNG (0900-7267864) 
(€ 0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 786) www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG (726-7864) www.samsung.com

PANAMA 800-7267 www.samsung.com

PERU 0-800-777-08 www.samsung.com

Country/Region Customer Care Center Web Site

PHILIPPINES

1-800-10-SAMSUNG(726-7864) 
for PLDT

1-800-3-SAMSUNG(726-7864) for 
Digitel

1-800-8-SAMSUNG(726-7864) for 
Globe

02-5805777

www.samsung.com

POLAND
0 801-1 SAMSUNG (172-678)

+48 22 607-93-33

www.samsung.com

PORTUGAL 808 20-SAMSUNG (808 20 7267) www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

ROMANIA

08010 SAMSUNG (08010 726 
7864) only from landline

(+40) 21 206 01 10 from mobile 
and land line

www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com

SENEGAL 800-00-0077 www.samsung.com

SERBIA 0700 SAMSUNG (0700 726 7864) www.samsung.com

SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com

SLOVAKIA 0800-SAMSUNG (0800-726-7864) www.samsung.com

Country/Region Customer Care Center Web Site
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SOUTH AFRICA 0860-SAMSUNG (726-7864) www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 678) www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

SWITZERLAND

0848-SAMSUNG (7267864, CHF 
0.08/min)

www.samsung.com/ch

www.samsung.com/
ch_fr(French)

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN
0800-329-999

0266-026-066

www.samsung.com

TANZANIA 0685 88 99 00 www.samsung.com

THAILAND
1800-29-3232

02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

UGANDA 0800-300 300 www.samsung.com

U.K 0330 SAMSUNG (7267864) www.samsung.com

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com

Country/Region Customer Care Center Web Site

UKRAINE

0-800-502-000 www.samsung.com/ua

www.samsung.com/
ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Region Customer Care Center Web Site
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Glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 
802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 
supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 
Mbps. 802.11b/g/n devices may occasionally suffer interference from 
microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 
wireless communication devices together on wireless local area networks 
(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 
feed an original sheet of paper so that the machine can scan some amount of the 
paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) and is 
now deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 
color of a single pixel in a bitmapped image. Higher color depth gives a broader 
range of distinct colors. As the number of bits increases, the number of possible 
colors becomes impractically large for a color map. 1-bit color is commonly 
called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file format 
on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 
address automatically. This is usually done in the bootstrap process of 
computers or operating systems running on them. The BOOTP servers assign 
the IP address from a pool of addresses to each client. BOOTP enables 'diskless 
workstation' computers to obtain an IP address prior to loading any advanced 
operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 
Locking mechanism is also used to hold the CCD module to prevent any damage 
when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 
selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 
instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 
example, 5% coverage means that an A4 sided paper has about 5% image or text 
on it. So, if the paper or original has complicated images or lots of text on it, the 
coverage will be higher and at the same time, a toner usage will be as much as 
the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 
data between disparate applications. The file format, as it is used in Microsoft 
Excel, has become a de facto standard throughout the industry, even among 
non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 
automatically feed and turn over an original sheet of paper so that the machine 
can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 
reset, or initialized.
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DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 
protocol. A DHCP server provides configuration parameters specific to the DHCP 
client host requesting, generally, information required by the client host to 
participate on an IP network. DHCP also provides a mechanism for allocation of 
IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 
DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 
a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 
with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 
runs back and forth on the page and prints by impact, striking an ink-soaked 
cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 
printing. Generally, higher DPI results in a higher resolution, more visible detail 
in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 
service which enables a user to use a single telephone line to answer several 
different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer equipped with 
a Duplex Unit can print on both sides of paper during one print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 
month. Generally the printer has the lifespan limitation such as pages per year. 
The lifespan means the average capacity of print-outs, usually within the 
warranty period. For example, if the duty cycle is 48,000 pages per month 
assuming 20 working days, a printer limits 2,400 pages a day.
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ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 
fax machines or fax modems. It automatically detects and corrects errors in the 
fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 
that the second system behaves like the first system. Emulation focuses on exact 
reproduction of external behavior, which is in contrast to simulation, which 
concerns an abstract model of the system being simulated, often considering its 
internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 
networks (LANs). It defines wiring and signaling for the physical layer, and frame 
formats and protocols for the media access control (MAC)/data link layer of the 
OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 
was included in the original Macintosh (1984) and is now deprecated by Apple 
in favor of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 
third party device such as a coin operated device or a card reader. Those devices 
allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol (such as the Internet or an 
intranet).

Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 
a heat roller and a pressure roller. After toner is transferred onto the paper, the 
fuser unit applies heat and pressure to ensure that the toner stays on the paper 
permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

A connection between computer networks, or between a computer network 
and a telephone line. It is very popular, as it is a computer or a network that 
allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image when color 
images are converted to grayscale; colors are represented by various shades of 
gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 
colored areas consist of a large number of dots, while lighter areas consist of a 
smaller number of dots.

Mass storage device (HDD)

Mass storage device (HDD), commonly referred to as a hard drive or hard disk, is 
a non-volatile storage device which stores digitally-encoded data on rapidly 
rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 
non-profit, professional organization for the advancement of technology 
related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 
Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 
type on the end of the parallel cable that attaches to the peripheral (for example, 
a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of an 
organization's information or operations with its employees. Sometimes the 
term refers only to the most visible service, the internal website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 
identify and communicate with each other on a network utilizing the Internet 
Protocol standard.
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IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 
rate indicates the number of single-sided sheets a printer can complete within 
one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 
well as managing print jobs, media size, resolution, and so forth. IPP can be used 
locally or over the Internet to hundreds of printers, and also supports access 
control, authentication, and encryption, making it a much more capable and 
secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 
networking protocol used by the Novell NetWare operating systems. IPX and 
SPX both provide connection services similar to TCP/IP, with the IPX protocol 
having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 
primarily designed for local area networks (LANs), and is a very efficient protocol 
for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 
standard-setting body composed of representatives from national standards 
bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 
established to standardize and regulate international radio and 
telecommunications. Its main tasks include standardization, allocation of the 
radio spectrum, and organizing interconnection arrangements between 
different countries to allow international phone calls. A -T out of ITU-T indicates 
telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 
no loss of accuracy or quality, which was designed for compression of binary 
images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 
method of lossy compression for photographic images. It is the format used for 
storing and transmitting photographs on the World Wide Web.
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LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 
querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 
of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 
network adapter. MAC address is a unique 48-bit identifier usually written as 12 
hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 
is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 
and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 
functionality in one physical body, so as to have a printer, a copier, a fax, a 
scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the amount of 
data that needs to be transmitted between the fax machines to transfer the 
image recommended by ITU-T T.4. MH is a codebook-based run-length 
encoding scheme optimized to efficiently compress white space. As most faxes 
consist mostly of white space, this minimizes the transmission time of most 
faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-
T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 
demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 
encodes the first scanned line using MH. The next line is compared to the first, 
the differences determined, and then the differences are encoded and 
transmitted.
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NetWare

A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the network 
protocols were based on the archetypal Xerox XNS stack. Today NetWare 
supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 
print using a laser beam emitted from a laser printer, and it is usually green or 
rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 
in the printer, and it should be replaced appropriately since it gets worn from 
contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 
which is copied, reproduced or translated to produce others, but which is not 
itself copied or derived from something else.

OSI

Open Systems Interconnection (OSI) is a model developed by the International 
Organization for Standardization (ISO) for communications. OSI offers a 
standard, modular approach to network design that divides the required set of 
complex functions into manageable, self-contained, functional layers. The layers 
are, from top to bottom, Application, Presentation, Session, Transport, Network, 
Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 
developed by HP as a printer protocol and has become an industry standard. 
Originally developed for early inkjet printers, PCL has been released in varying 
levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems for representing two dimensional documents in a device 
independent and resolution independent format.



Glossary

217 Glossary

PostScript

PostScript (PS) is a page description language and programming language used 
primarily in the electronic and desktop publishing areas. - that is run in an 
interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 
printer.

Print Media

The media like paper, envelopes, labels, and transparencies which can be used 
in a printer, a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 
a printer works, meaning the number of pages a printer can produce in one 
minute.

PRN file

An interface for a device driver, this allows software to interact with the device 
driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 
public circuit-switched telephone networks which, on industrial premises, is 
usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 
user authentication and accounting. RADIUS enables centralized management 
of authentication data such as usernames and passwords using an AAA 
(authentication, authorization, and accounting) concept to manage network 
access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 
the greater the resolution.
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SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 
printers, serial ports, and miscellaneous communications between nodes on a 
network. It also provides an authenticated Inter-process communication 
mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 
across the Internet. SMTP is a relatively simple, text-based protocol, where one 
or more recipients of a message are specified, and then the message text is 
transferred. It is a client-server protocol, where the client transmits an email 
message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 
wireless devices in a WLAN use the same SSID in order to communicate with 
each other. The SSIDs are case-sensitive and have a maximum length of 32 
characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 
which part of the address is the network address and which part is the host 
address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 
communications protocols that implement the protocol stack on which the 
Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 
such as job status, transmission result and number of pages sent. This report can 
be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 
format. TIFF describes image data that typically come from scanners. TIFF 
images make use of tags, keywords defining the characteristics of the image that 
is included in the file. This flexible and platform-independent format can be 
used for pictures that have been made by various image processing 
applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 
toner. Toner is a powder used in laser printers and photocopiers, which forms 
the text and images on the printed paper. Toner can be fused by by a 
combination of heat/pressure from the fuser, causing it to bind to the fibers in 
the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 
scanner with a TWAIN-compliant program, a scan can be initiated from within 
the program. It is an image capture API for Microsoft Windows and Apple 
Macintosh operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 
in Window NT and other Microsoft products. The format of a UNC path is: 
\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 
resources on the Internet. The first part of the address indicates what protocol to 
use, the second part specifies the IP address or the domain name where the 
resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 
Implementers Forum, Inc., to connect computers and peripherals. Unlike the 
parallel port, USB is designed to concurrently connect a single computer USB 
port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 
when viewed by transmitted light. Watermarks were first introduced in Bologna, 
Italy in 1282; they have been used by papermakers to identify their product, and 
also on postage stamps, currency, and other government documents to 
discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 
provide the same level of security as that of a wired LAN. WEP provides security 
by encrypting data over radio so that it is protected as it is transmitted from one 
end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 
introduced in Windows Me and Windows XP. A scan can be initiated from within 
these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 
computer networks, which was created to improve upon the security features of 
WEP.
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WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 
home users. A shared key, or password, is configured in the wireless access point 
(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 
key for each session between a wireless client and the associated WAP for more 
advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 
network. If your wireless access point supports WPS, you can configure the 
wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 
(PDL) and a new document format, which has benefits for portable document 
and electronic document, developed by Microsoft. It is an XML-based 
specification, based on a new print path and a vector-based device-
independent document format.
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